Thomson Reuters Eikon

Service Description

Version 1.0

Date of issue: June 2018 5...:’ THOMSON REUTERS®



Table of Contents

Contents
[©10] 01 (=T 0] ST SRS UPPP PPN 2
P o Lo 101 a1 B Lo ol U ] ' =T o | A 4

Intended Readership

[N RIS DOCUMEBNT ...ttt ookt oo ettt oot e e 4kt e o Rk et e ok et e 4k bt e e e st e oot et e e e h et e e et e e e e b e e e e annreeea
TROMSON REULEIS EIKON ...ttt ettt e ettt e bt e bt e e bt e et b e e e e e bt e e bt ettt eene et s 5
A, ETKON VAITANTS. ...ttt e et e bt e b et e e h et b ettt 5
D, SCOPE ANU SCAIE......eei ittt ootk e oo Rt R et et e et 5
N B 1Yot o) TP ST PP PP PP PPPRP 7
2. EVAIUALE ...t b L LR R E R £ R £ £ R LR £ R e 4Rtk e R et e bttt nh e 7
B THIAIS ettt E e e E b e e e £ b et e et e e 7
(oS0 o] oo a @l B0 ¢ o B W A= T S PP T PP PP PP PPPPRPPPI 7
C. Trials Of Partner APPICALIONS ......ccoiiiiieii ettt ettt ekt e ekt e ettt e e b e e et e e e e e e 7
3. PUICNASE & REMEW ...ttt ettt b ekt e bt ek e b4kt £k b e 4 H £ ekt oo he e ekt e ket e kbt e e hb e e s bt e e an e e st e e aseeenir e 7
a. Ordering ThOMSON REULETS EIKON ......coiiiiiii ettt e e et e e e ettt e e et e e e an bt e e es e e e amaeeeeantbeeeenneeeeennees 7
b. Purchasing Additional APPICALIONS .........eeiiiiiie ettt ekt e e st et e e st e e e e s nreees 7
C. PUrchasing AddItIONAI CONIENT..........uiiiiiiiie ittt et e et e et e ek bt e e e e et e e b et e e enb et e e anee e e e 8
(o TR =111 1T Vo I TP PTR S TOPPPPP 8
L O LT Y o g (=T o = g Tod T PP P PP P RPUPPPN
f. Renewals and Cancellations
A S U ettt 8
E T D= o] (o) Y71 0 =T o | TP P PP TOPPPPP 8
o [0 151 7= 1/ = LA o TSP PO PP PP PP PPPPP PP 9
C. INSLAllAtiON HOUIS Of COVEIAQE. ......eiiieiiiie ettt e ke e et e e et e ekt e e e e et e e e e e e 10
0. SUCCESSTUI INSTAITATION ...ttt e et e e st e e ek et e et e e et e e e e sre e e e e 11
LT o oL [0 Tt R U 7= o =T UPR TP 11
A. Product HOUIS OF AVAIADIIITY .......ooiiiiiiiiee et h et e et e e ekt e et e et e e et e e 11
L o o To [U[ox = T o U= To =T PP OP PR PPPRN 11
(oS 1o U 1 OO RTP PRI 12
LCTE ST U] o] o o] £ AT PP TP P TP P TR PRTRPRTRPRPRPRPIN 13
a. Training aNd DOCUMENTALION . .......citiiiiiitie ettt ettt e et e ek bt oo a bt e e e bt e e e bt e e st e e et e e anbe e e e nanes 13
Lo T EY o] IS U] o] o Lo PP PP PR PPPRN 13
c. Languages and Availability
(o ST o] ool A1 /(o T [T A T T PP PP OP PP PUPRN
€. Service Level TargetS and DESCIIPLIONS ....coiuuiiiiiiiie ittt ettt e et e et e et e e et e e e st e e e 14
L =V (L= TN o] o Lo i AP RRRT 16
(o OTo o1 11U Lo T ISR [T o] £ )Y/=T 0 =] o | SRR 16
T EVOIUTION ..ottt h ekt b ekt h ek b e E e b £ bt b bRt e b e e bt bbbt e et 16
E= T U o T o (PSP PP PP 16
Lo T O oo [ =T [ USRI 16



(o Y [To ] = L1 o] o SO SPPR R POPPPPPP 16

Addendum 1 — Thomson REULErs EIKON GAIBWAY .........ccuuviiiie e ittt e ettt e e e e et e e e e e e e e e e e e e e ebb e e e e e e e e s sataeaeeeeeesenassenes 17
= T T 0] o] (=10 0 T=T o1 7= 14 o] o [ RRT PP 17
Addendum 2 — ThomSON REULETS EIKON APIS. ..ottt e et e et e e e bt e et e e e e e s 18
- TS ToTo] o ToI= g o IS or- | L= TSSO PPTR RSP PP 18
Lo T I U (o = U (o 1T Lot RO PT P PPPPPP 18
(o N o] o IS 10 To [T 1 Y PP PO P PP OP PP PUPRPN 18
(o TR ST [ o) VS o L= Y OO TR T PPRTIR 18
e. Eikon data API
LT O 1Y A . PRSP ERRR I
O NET AP 19
LA N o) (I @ I o IO L Vo = PSSR 19
L DUHSCOVET ...ttt etttk ekt ekt E ekt ek ek £ 4k £ ke £k £ R4 A4 a e R £ e oA e A e A et e ettt ettt 19
L= T O o ] 7= Lo TSP P PP PP PPPTPT 19
A V= [V (= OO PR P PP PR PPPPT PRSP 19
LS T I = T T PP PR PR PRSP 19
Lo TS T o] o o o PSPPSR 19
3. PUICNASE & REMEW ...ttt ettt oo bt 4ot e 4okt e 442k et £ 4k et e 4 H bt e e e skttt e 4k et e e e n kbt e e e bb e e e e i e e e e anbreeen 20
E= T = 01 (11 (=T 1= oL (O TP P PP PP PP PUPRPN 20
Lo = Tod ez To L aTo J=Ta o I O o] 11 = od A OO PP PRSP PPPPPP 20
A S U ettt 20
E BT 11T 1 O P TP UP PP PUPRPN 20
D, INSTAIALION ASSISTANCE ... .eeieiitie ettt e ket e oo sk et e o b et e ekt e e e bt e e e b e e e et e e 20
LT o oL [0 Tt R U 7= o = TP UPT TP 21
E= T = 0V ][] =T U L= To = PP T PO P PP OP PP PUPRN 21
D, SEIVICE AVAIADIITY ..ottt e h et 21
(oS T Tox U PO P PP PPPPPP 21
LCTE ST U] o] o o] 1 AT TP TP P PP P TR PRTRPPPRPRPRPRPIN 22
E= T I - U o1 oo [T UP PP PUPRN 22
D. API CONfIGUIALION SUDPPOIT ... ettt ettt oot e ettt e e skt ookt e e ekt e e ettt e et e e e e st e e et e e e nnnes 22
c. Eikon Content and TECHNICAI SUPPOIT ..ottt e e e e e ettt e e e e e e bt e e e e e e e s nnb b e et e e e e e annebaeeeaens 22
d. Support Channels, Support Languages and AVAIIADIILY ...........oouueeiiiii e 22
(SIS0 o] o o] A1 /(oo [T EO TP OP PP PPPRN 22
A =AY /o [V (o] o O PP OO PP PR PPPPPTPPRPN 23
E= T U o T o (PRI 23
Lo T\ o 7= 11T LSOO ERTP PP 23
(oS 1 - Yo | (oY, [T = Ui oo FO PSP PRTR P PPPPPP 23



About this Document

INTENDED READERSHIP
This document is available for prospective and current customers of Thomson Reuters Eikon.

IN THIS DOCUMENT

This document describes the service that customers of Thomson Reuters Eikon can expect, alongside the experiences and
choices that Thomson Reuters Financial & Risk has designed for you to have. It covers all the stages of your interactions with
the company, from initial interest through to end of usage. It is not a legally binding document but intended to give a reasonable
expectation of the service you will receive as part of Thomson Reuters Eikon.

Please refer to this document for any information about the service included with Thomson Reuters Eikon, whether as a
prospective or ongoing client. If you have any further questions, do not hesitate to contact us in any of the channels listed below.
More information about the general service offered by Thomson Reuters Financial & Risk is available upon request in the form
of the Statement of Service.



Thomson Reuters Eikon

With Eikon, you can quickly uncover hidden opportunities with access to comprehensive data and unique content.

Highly visual and intuitive to use, Eikon is the ultimate set of financial analysis tools. Integrate multiple workflows, co-create
applications and securely access other financial professionals to make better decisions.

And, unlike some others, we don’t operate on a one-size-fits-all model, so whether you are a startup or a large corporate, we
can help you find the relevant level of content and features that suits your needs.

Eikon is available for Windows, in a browser and on mobile devices. So getting started with Eikon is easier than you think.

A. EIKON VARIANTS

Different firms and different roles require different content, tools and workflows. Thomson Reuters offers a range of Eikon
variants that have been created to suit the needs of specific users. More information can be found by speaking with your
Account Team. Note that some areas of service for select variants are covered in the Addendums section

B. SCOPE AND SCALE

Thomson Reuters Eikon is available for new and current customers of Thomson Reuters globally.



CHOOSE YOUR VARIANT

¢ Thomson Reuters Eikon
* Thomson Reuters Eikon for Commodities
e Thomson Reuters Eikon Research and Advisory

* Thomson Reuters Eikon North American Fixed Income
¢ Thomson Reuters Eikon for North American Securities
* Thomson Reuters Eikon for Latin American Securities
e Thomson Reuters Eikon for European Securities

* Thomson Reuters Eikon for Asia / Pacific Securities

e Thomson Reuters Eikon Core

e Thomson Reuters Eikon Exchange Pricing

e Thomson Reuters Eikon Gateway™

CHOOSE YOUR DEPLOYMENT

e Thomson Reuters Hosted

* Thomson Reuters Managed
e Customer Managed

* Web

CHOOSE YOUR INSTALLATION

e Self-Install
¢ Remote- Engineer Installation
¢ On-Site Engineer Installation

*Some configurations may not be available; Speak to your Account
Team for more information



1. Discover

To find out more about how Thomson Reuters Eikon can help you please visit http://financial.thomsonreuters.com/eikon. View
capabilities by content and features or markets and industries and get in touch directly from the website. To speak with
someone immediately please Contact Us.

2. Evaluate

A. TRIALS

Free trials of all variants of Thomson Reuters Eikon* are available in order to evaluate the content and features that are
available within. Free trials are set up via speaking with your Account Team, and last for a period of up to 30 days. Once a free
trial period is over and a purchase made a user can continue using Eikon seamlessly. If no purchase is made the user will lose
access to Eikon when the trial concludes.

B. SUPPORT DURING TRIALS

Thomson Reuters offers the same level of support to those on trials as it does to licensed users. More information on support
can be found later in this document.

C. TRIALS OF PARTNER APPLICATIONS
Once a user has started a trial of Thomson Reuters Eikon they can also trial any partner applications that allow for free trials.

3. Purchase & Renew

A. ORDERING THOMSON REUTERS EIKON

New customers should request an Eikon license via their Account Team. If you do not know your Account Team you can
Contact Us and we will make sure you get to the right person. Thereafter, customer administrators can order additional
applications using License Management tools in My Account. If a customer is not set up to order additional applications through
My Account they can request additional licenses via their Account Team.

Requests completed through the License Management tools in My Account have a target completion time of three (3) hours.
Requests completed via the Account Team have a target completion time of three (3) business days.

B. PURCHASING ADDITIONAL APPLICATIONS

I.  Buy Thomson Reuters Apps

Thomson Reuter’s applications are not available for purchase individually, but are packaged into ‘Variants’ based on users’
workflows. Thomson Reuters Eikon Premium contains all of the available Thomson Reuters applications. Account Teams are
available to discuss the best variant to suit individual needs.

Il.  Buy Partner Apps
Partner applications are found in the App Studio section of the App Library. Partner applications can be purchased using the

‘Purchase’ button. Partner apps are any application created by a third party and sold and distributed through Thomson Reuters
Eikon.

In most cases the user will get instant access to the partner application, and cost of the app will be added to your Thomson
Reuters bill. Where this is not the case the partner will contact the user directly.

Questions relating to trials and purchase will be handled by the partner. Apps include clear instructions for contacting partner
support in the footer of the app as well as in the App Studio section of the App Library.

Free Trials

Free trials are available for most partner applications. The availability of free trials with Partner applications is noted by the ‘Free
Trial’ button in the App Studio section of the App Library.


http://financial.thomsonreuters.com/eikon
https://financial.thomsonreuters.com/en/contact-us.html
https://financial.thomsonreuters.com/en/contact-us.html
http://myaccountfinancial.thomsonreuters.com/
http://myaccountfinancial.thomsonreuters.com/
http://myaccountfinancial.thomsonreuters.com/

Ill. Accessing Applications
Users can access core and purchased applications via the App Library and in the Eikon Menu.

C. PURCHASING ADDITIONAL CONTENT

Customers can purchase additional Thomson Reuters and partner content by requesting it from their Account Team. A
catalogue of content available for purchase can be found in the Content Kiosk application in Eikon. It can be found in the App
Library or by searching “Content Kiosk”.

Additional Content can also be purchased by customer administrators via the License Management tool in My Account. If the
user already has a Product License, they can purchase all available add-ons for that product as well.

D. BILLING

Customers are billed according to the billing frequency specified for their account. Some partner services are on a direct billed
model which means that they are billed directly by the Vendor based on their own billing rules. For more details, the customer
should contact their Account Team.

I.  Partner Applications and Content
In most cases cost of the partner app or content will be added to your Thomson Reuters bill. Where this is not the case the
partner will contact the user directly.

E. USER MAINTENANCE

There are various situations where changes need to be made to a license. The most efficient method of completing these
changes is by client administrators using the License Management tools in My Account. Where this is not possible, changes can
also be made by Account Teams at the request of clients.

I.  Maintenance Scenarios

Process l Self-Service Availability
Purchase (Product & Add-ons) v’ (same product only)
User Swap v
Assign/Un-assign licenses v
User detail changes v
Cancellation v
Relocation .x .across borders
v' within the same country

F. RENEWALS AND CANCELLATIONS
For details on renewal and cancellation terms, customers should contact their Account Team.

4. Setup

A. DEPLOYMENT
Thomson Reuters offers customers different methods of deploying the desktop version of Thomson Reuters Eikon. Please
speak with your Account Team about which deployment method is most suitable.

I.  Thomson Reuters Hosted
All infrastructure sits with Thomson Reuters, and Eikon connects through the Internet.

Il. Thomson Reuters Managed
Some infrastructure sits on the customer’s site, and Eikon connects through private lines.


http://myaccountfinancial.thomsonreuters.com/
http://myaccountfinancial.thomsonreuters.com/

Ill. Customer Managed
Infrastructure is based on a Market Data System like Thomson Reuters Enterprise Platform (TREP), and Eikon connects
through private lines.

B. INSTALLATION

I.  Windows Desktop

Thomson Reuters Eikon is available via a simple self-download and installation. Self-installation is the most efficient method of
deployment available, and installation does not require administration rights on the user's computer when installed per user. It is
possible that a client’s security settings may be such that administration rights are required to install any applications, but the
framework itself does not require them. Administration Rights are required if installing Thomson Reuters Eikon per machine.
Thomson Reuters Eikon can also be packaged for mass deployments as outlined in the IT-Managed Installation Guide.

Implementation Assistance
Thomson Reuters Eikon can be implemented at a client site directly by the client. Thomson Reuters also offers two forms of
implementation assistance.

Installation Assistance
Clients can choose to have Thomson Reuters manage the implementation of Thomson Reuters Eikon so that they can focus on
core activities. This service can be requested via your Account Team. There are two levels of service available:

Remote Assistance
There is no charge for remote implementation assistance. The service is available 24 / 5, and upon request weekend coverage
can be offered.

On-site Assistance
On-site implementation assistance is available at an additional charge. Assistance can generally be given in local language, and
is offered during local business hours. There are additional charges for assistance outside of normal business hours.

Installation Support
For failed installations, Thomson Reuters will follow the processes mentioned in the Support section of this document.

Installation Support Hours
Frontline support is available 24 / 7.

Installation escalation teams are available 24 / 5.

.  Web
Thomson Reuters Eikon Web Access requires no installation aside from a compatible browser.

Ill. Mobile
Thomson Reuters Eikon Mobile versions are installed from the App Store of you compatible device.



http://eikon.thomsonreuters.com/
https://customers.thomsonreuters.com/a/support/paz/pazDocs.aspx?dId=555910
https://customers.reuters.com/a/support/paz/pazDocs.aspx?dId=555349

IV. Eikon 4 System Requirements

Overview
Recommended requirements l Minimum requirements
Operating System: Windows 7, 8, 8.1, 10 64-hit Operating System: Windows 7, 8, 8.1, 10 64-bit
Processor: Intel 5th Generation Core i7 Processor: Intel Core 2 Duo, 2.4GHz or higher
Physical memory: 8 GB RAM Physical memory: 4 GB RAM or higher
Free disk space: 5GB Free disk space: 1.6GB or higher
Video card: PCI Express (PCle) card with minimum of Video card: PCI Express (PCle) card with minimum of 128MB
256MB memory per port. DirectX 11.x. compatible memory per port. DirectX 9.x. compatible
Color depth: 32-bit Color depth: 16-bit
Temporary internet files size: 250 MB or higher Temporary internet files size: 250 MB or higher

In addition to the more detailed System Requirements, these are the requirements for Thomson Reuters Eikon. Please consider
all requirements of any other applications that you plan to run alongside Thomson Reuters Eikon.

There is a system test that a user can run before the installation to check that their systems can support Eikon. More
information can be found in the System Test Guide.

V. Eikon Web System Requirements

e Chrome (Latest 5 versions)
e  Safari 8+
e Internet Explorer 11

VI. Eikon Mobile System Requirements

Apple i0OS
Requires iOS 8.0 or later. Compatible with iPhone, iPad and iPod touch.

Android
Requires Android 4.1 and up.

Find out more about our Mobile Apps

VIlI. Welcome Emails

Either through a free trial (where available) or a purchase completion, users will receive a Welcome Email (WE) containing links
to their login credentials and the product download page. The URL will point to a location specific to downloading Eikon.
Welcome emails are generated automatically while setting up a user. This will either be by the Thomson Reuters Account
Team or the client’s administrator using License Management in My Account.

Welcome emails can be delivered in the following languages:

Traditional Chinese* Simplified Chinese German English French

Italian Japanese Russian Spanish

*Traditional Chinese is not available for customers using License Management in My Account.

VIII. Profile Information

During Eikon setup a user will enter profile information that includes Job Function, Asset Class and Geographic Focus. These
are used to help customize the experience for each person — making it easier to find the features and functionality important to
them.

C. INSTALLATION HOURS OF COVERAGE

Installation is available 24 / 7 in a digital, self-service fashion over the Internet, via a link from the Welcome Email. Administrator
rights are not necessary in most cases when installing Thomson Reuters Eikon.
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A successful installation has been completed after downloading, installing, and logging in to the product.

THOMSON REUTERS EIKON @

INSTALLATION

Thomson Reuters Eikon Desktop 4.0.42 (v4.0.42144) has been installed.

»

CONGRATULATIONS
YOU ARE NOW READY TO USE THOMSON REUTERS EIKON.
ANEW SET OF FINANCIAL TOOLS FOR A NEW GENERATION
OF FINANCIAL PROFESSIONALS

Start Product

Thomson Reuters Eikon is an individual information service, meant to be installed on a user’s PC for the use of the licensed
user only. Detailed information on allowed usage can be found in your contract. Usage of interactive services are covered in
The Code of Conduct for Thomson Reuters’ Interactive Services. If you have additional questions please contact your Account
Team.

Thomson Reuters Eikon is available 24 / 7 without any differentiated tiers of availability.

Thomson Reuters Eikon can be delivered in the following languages:

English Chinese Japanese

Product language can be changed by selecting the appropriate language from the language dropdown on the log-in screen, and
from the Eikon menu > Settings > Languages.

English

THOMSON REUTERS English
B35
AR

User ID:

Password:

Sign In Cancel

11
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C. SECURITY

As the world's largest financial information source, Thomson Reuters is serious about safeguarding the security and quality of
all the proprietary and third-party information that flows through our systems. That's why we've taken steps to formalize and
embed the information security management and quality management systems into the Information Technology Infrastructure
Library, (ITIL) service management processes operated in our major data centers - including attaining certifications in two
industry-proven global standards ISO 9001 (Quality Management) and the new ISO 27001 (Information Security Management).

More information can be found in our Statement of Service.

I.  How personal data is used within Eikon

Eikon makes available a large number of finance-related external and TR data sources and products, users search these and
can save the results of those searches as shortcuts/preferences. The product also uses data in word search terms input by
individual users, and stores them in order to enable the product to suggest previous search terms to enhance user experience.
Eikon collects and stores data relating to how and which users interact with the product (i.e. source/internal product hits, users'
job functions, locations and asset classes), for the purposes of tailoring the discoverability of applications and menus as well as
for support purposes. For more information please contact your Account Team.

Il.  Business Continuity (BC) and Disaster Recovery (DR)
Thomson Reuters Business Continuity Management Office (BCMO) maintains a business continuity policy. For further
information please contact your Account Team.

There are no options for customers to select levels of services for Thomson Reuters Eikon. By nature, any Hosted Thomson
Reuters Eikon product can be accessed via any Internet Connection. User profile, favorites, workspaces, and preferences are
all stored centrally so can be accessed anywhere. Thomson Reuters provides datacenter redundancy and failover. It is the
responsibility of the customer to obtain the correct level of service from their ISP in order to meet their own connectivity
resiliency needs.

Ill. Information Security

Thomson Reuters is committed to its Information Security program and the functions’ mandate is approved by the Executive
Committee. We have a Chief Information Security Officer and an extended team of security specialists, spread across the globe,
dedicated to the security of Thomson Reuters Financial & Risk products and services. Our commitment to security is achieved
through the application of demonstrable security controls at an appropriate level to the service being offered. Furthermore, our
security strategy ensures that appropriate security controls exist within service design and operation. This is to counter the
threats to the confidentiality, integrity and availability of customer information which we store, process or transmit. We have staff
trained to identify issues and resolve them as quickly as possible with minimal impact on its customers. Our involvement in
industry and government security forums and groups further demonstrates our proactive approach to understanding and
countering the threats we face.

IV. Privacy
Your privacy and trust are important to Thomson Reuters. Please consult our Thomson Reuters Privacy Statement for more
information.

V. Legal and Regulatory

Thomson Reuters global legal department will interpret the laws and regulations that apply in the countries we operate in and
provide appropriate policies to enable us to comply with them. We operate a 24 / 7 Business Compliance and Ethics Hotline for
guidance or to report ethical, legal or policy issues.

VI. Communications

External communications for release notes, new versions, product road map, product maintenance schedules, content change
notifications and documentation (training & user guides) updates are available through My Account and, if necessary, through
your Account Team.

VII. Security Patches

Any security issue will be assessed immediately upon being made aware of the issue. A software patch will be made available
as soon as a solution is identified and implemented. For any issue where Thomson Reuters is reliant on a third party for a
solution, communication to clients will be delivered via My Account.

12
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6. Support

Finding answers to questions and getting technical support is straight forward and easy with Thomson Reuters Eikon. There is
a range of self-help tools available directly in Eikon. Each application has its own Help content, accessed via the App Menu.
Users can also access help using the “?’ button on the toolbar and Help > Contact Us in the Eikon menu in order to contact
Thomson Reuters by chat, email or phone.

Customers and users can also contact Thomson Reuters directly from our Website.

Mobile users can access support from the Eikon menu > i button > Contact Us About a Problem.

A. TRAINING AND DOCUMENTATION

Training is available via the training app inside of Eikon and via My Account. Face to face training can also be requested by
using Help > Contact Us or contacting your Account Team directly.

B. VERSION SUPPORT

To ensure end-users get the most out of their Thomson Reuters Eikon experience Thomson Reuters will only support the
current and previous two (2) versions of Eikon.

e Reported issues will be fixed in upcoming versions.
e Fixes and enhancements are cumulative with each successive version.

e New features or apps may not work outside of supported versions.

C. LANGUAGES AND AVAILABILITY

I.  Live Chat

Live chat is a real-time support channel that is available for all Thomson Reuters Eikon users, but is not available in Eikon
Mobile. This can be accessed via Eikon Messenger in the product. Initiating a conversation with this contact will begin the
support process. Live Chat is available in English on a 24 / 7 basis. Local language support is available during local business
hours for the following languages:

Japanese Mandarin

Il.  Customer Support
Customer support delivered by phone and email using “Contact Us” links in the product will be delivered in Englishona 24 /7
basis. Local language support is available during local business hours for the following languages:

Arabic Cantonese French German Greek
Indonesia Bahasa Italian Japanese Korean Malay
Mandarin Polish Portuguese Russian Spanish
Thai Turkish Vietnamese

Ill. Resolver Groups

Resolver groups are used when an issue needs escalation for further investigation. They will deliver support in English only.

13
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D. SUPPORT MODEL

CUSTOMER

v

CUSTOMER SUPPORT DESK
Logs issues and undertakes 1st level diagnostic to resolve with client

STATUS UPDATE TO CUSTOMER

b

COMPLEX TROUBLESHOOTING
Resolve or determine cause and refer to appropriate resolver group

STATUS UPDATE TO CUSTOMER

- - v - -
COMMS PROVIDER NETWORK SECOND LEVEL CUSTOMER OTHER SERVICES
* Last mile delivery OPERATIONS * Technical TECHNICAL SERVICES * Training
+ Circuit related + Data delivery = Application + Field engineer * Permissions
+ Communications + Content * Solutions support * Global Software
issue * Customer issues Gateway
+ Central Systems * Site integration issues

THIRD LEVEL
s Softw
* Further so

Data production

« Data sources
* Product chan

v :
STATUS UPDATE TO CUSTOMER -+ s e e :

E. SERVICE LEVEL TARGETS AND DESCRIPTIONS

In order to make sure we are doing everything we can to meet and exceed our customers’ expectations we have set the below
target response times with regards to contacting Thomson Reuters Support.

0O © O

GET HELP Live Chat htto://myaccountfinancial.tr.com

Response within 20 seconds A .
Response within 1 minute ‘:Globa.r Contact Numbers Response within 15 minutes

14
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ESCALATION
Escalate Escalate t
SEVERITY SCASRRY $0 be“;':d

Regional Manager

1; lete foss of Service for Immediate Immediate 4 hours Immediate

Customer Status Updates : Every Hour

1 hour 1 hour 4 hours 1 hour

3

l‘

»
P
L
N
<

v s mx' user; Loss of resthency

) Customer Status Updates - Daily

A 24 hours
Non - Service atfectuing

Customer Status Updates : Daily o as agreed

PLEASE NOTE: A customer site issue is a service impacting event related to Thomson Reuters’ hardware or software that is
located at the customer premises. Issues related to Hosted Products, where Thomson Reuters’ hardware and software is
located on Thomson Reuters’ premises, follow the same restoration targets.

I.  Severity Descriptions
Thomson Reuters endeavors to respond to all customer concerns promptly. To match the response time against the level of
urgency, Thomson Reuters Customer Support assigns a priority level based on the problem severity.

Severity 1: An emergency situation in which both primary and any standby systems produce materially incorrect results, fail
catastrophically or are otherwise rendered inoperable and in which all or multiple end users (two or more) are simultaneously
experiencing the same failure. (Please note: This excludes non-resilient communication line failures as well as single key station
sites). Severity 1 also covers the situation where key content is either not available or is not updating. Examples of key content
are “Premium Category” exchanges, futures rollovers, G24 FX & money, G24 government benchmarks, real-time indices and
missing historical data for a whole market.

Severity 2: This means some elements of Thomson Reuters service affecting multiple end users (two or more) simultaneously,
is inoperative which results in loss of content, functionality or degraded performance, but where a temporary workaround is
available. Additionally, any loss or compromise of a standby part of a solution not directly impacting the customer, but through
which the risk of incurring a Severity 1 situation is greatly increased, would be included. Severity 2 also covers an emergency
situation whereby a single user workstation or single communication line delivered site has failed catastrophically or is otherwise
rendered completely inoperable, and the situation where real-time content is suspect in accuracy or is missing.

Severity 3: When non real-time content is suspect in accuracy or is missing and all other customer service impacting problems.
Severity 4: All non-service impacting requests such as product enhancements.

Il. Dispatching Field Engineers

If a Thomson Reuters Customer Support center specialist cannot resolve your issue remotely, a field engineer may be
dispatched to your location, provided the issue is Thomson Reuters related or you subscribe to a premium dispatch service. In
cases the incident has its root cause within the customer’s environment this may result in service charges on a time/materials
basis. Where there is a realistic expectation that a dispatched engineer will be able to solve the issue more expediently than a
remote support technical specialist, the Thomson Reuters Customer Support center will send the Case to a dispatch team, who
will contact the appropriate field engineer immediately for dispatch. Field engineers can be dispatched during local business
hours of each country, keeping in mind local holidays and daylight savings time. The field engineer will make all reasonable
efforts to get to your location as soon as possible. In the event of a delay, the field engineer or the specialist from the dispatch
team will inform you of the estimated time of arrival.
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PLEASE NOTE: Thomson Reuters reserves the right to charge a fee, at our nominal time and materials rate, for service issues
that require on-site field engineering assistance which are the direct result of certain customer induced problems or outside of
normal hours.

F. PARTNER SUPPORT

Partners will provide direct support for their apps. Apps include clear instructions for contacting partner support in the footer of
the app as well as in the App Library.

G. CONTINUOUS IMPROVEMENT

Thomson Reuters is committed to continuously improving its’ products and support. After interacting with an employee of
Thomson Reuters, customers may receive an opportunity to give their feedback via an email.

7. Evolution

A. UPDATES

I.  Thomson Reuters Eikon Desktop
General updates happen automatically, and do not require any installation or action from users or market data/client
administrators.

For small version updates (e.g. Eikon v4.4 to Eikon v4.5) which may require a reinstall, market data/client administrators will be
made aware in advance via a Product Change Notification (PCN) in My Account, and the updates will happen automatically.
Speak to your Account team about the services Thomson Reuters offers to assist with small updates.

Thomson Reuters Eikon can also be packaged for mass deployments as outlined in the |T-Managed Installation Guide.

Client administrators can see which versions their users are on via My Account. Users can see the same in Help > About
Thomson Reuters Eikon.

The implementation team will not install any versions of Eikon older than the previous two. The latest version can always be
found at: http://eikon.thomsonreters.com. Previous versions will be available from My Account.

II.  Thomson Reuters Eikon Web Access
Users are always presented with the most current version of Eikon Web Access each time they log in.

Ill. Thomson Reuters Eikon Mobile
Updates to Eikon Mobile are made available in the relevant App Store. Updates are optional, but may have a minimum
operating system requirement. Thomson Reuters reserves the right to require compulsory updates to Eikon Mobile.

B. UPGRADES

Larger product upgrades are major changes in a product version (e.g. Eikon v3 to Eikon v4), and can consist of changes to
connectivity as well as workflow. Thomson Reuters will notify customers of a new version via a Product Change Notification
(PCN) in My Account. Thomson Reuters offers a range of upgrade assistance options. Please contact your Account Team in
order to discuss upgrade needs.

Where an upgrade requires migration from a legacy component to a new one, Thomson Reuters will, where possible, provide a
migration tool for users. Where this is not possible Thomson Reuters will offer migration assistance

C. MIGRATIONS

Thomson Reuters offers migration assistance to existing customers of Thomson Reuter’s products (strategic migration) as well
as to new customers migrating from other financial market data products (competitive migration).

Customers will be notified of any mandatory strategic migrations via a Product Change Notification (PCN) in My Account.
Thomson Reuters offers a range of services to assist with migrations. Your Account Team will work with you on migration
plans.
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Addendum 1 — Thomson Reuters Eikon Gateway

Thomson Reuters Eikon Gateway is the capability that enables customers to maximize the value that they get from Thomson
Reuters Eikon by allowing users to access our platform and purchase applications on an individualized basis. Customers can
purchase one or more of the Gateway Applications, and receive access to the application as well as the content required to run
that application. Six core applications are included in Gateway: Home, Monitor, Quote, News, Financial Chart and My Profile.
Thomson Reuters Eikon Gateway is available via a web browser and our desktop framework on Windows.

Available Thomson Reuters Gateway Applications

There are some areas where the service offered for Thomson Reuters Eikon Gateway differs from the other variants. These
differences are found below.

A. IMPLEMENTATION

I.  Scope and Scale
Thomson Reuters Eikon Gateway is only available for new users. This can be clients new to doing business with Thomson
Reuters and users at existing clients that do not use Eikon.

II.  Product Administration / Permissioning

Thomson Reuters on Eikon Gateway is not available on its own, but can only be used with a purchased application. The
application and content are packaged together. Clients will have both the tools to visualize the information along with the
underlying content.

New and existing customers should request the first application via their Account Team. This will give the user both the
application and the Thomson Reuters Eikon license.

Thereafter, customer administrators can order additional applications using License Management tools in My Account. If a
customer is not set up to order additional applications through My Account they can request additional licenses via their Account
Team.

Requests completed through the License Management tools in My Account have a target completion time of three (3) hours.
Requests completed via the Account Team have a target completion time of three (3) business days.

Ill.  Purchasing Additional Applications
All applications can be found by navigating to the ‘Get Apps’ link from the Home tab.

Buy Thomson Reuters Apps

Applications can be purchased by clicking on Contact Sales link from the ‘Buy Thomson Reuters Apps’ page and completing an
online form to initiate our sales support process, by a customer administrator using License Management in My Account, or by
contacting your Account Team directly.

Welcome Emails
In addition to the standard Eikon Welcome Email, new users will also receive an Application Welcome Email that will introduce
the user to the purchased application. Purchases of additional applications will only generate an application email.

Buy Partner Apps

Navigating to the ‘Buy Partner Apps’ link will open the App Studio section of the App Library where a selection of partner apps
are available. Partner applications can be purchased using the ‘Purchase’ button. Partner apps are any application created by a
third party and sold and distributed through Thomson Reuters Eikon.

Free Trials

Free trials are available for some Thomson Reuters applications. Customer administrators using License Management in My
Account will be able to see free trial availability, and Account Teams will also have this information. The availability of free trials
with Partner applications is noted by the ‘Trial’ button in the App Studio section of the App Library.

IV. Accessing Applications

Users can access core and purchased applications via the App Library, the Eikon menu and the ‘Launch Apps’ link on the
Homepage.
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V. Product Functionality
Thomson Reuters Eikon Gateway will be delivered in English only, with the exception of some specific applications. As they are
released, these applications will be noted in this document.

DealWatch Japanese

Addendum 2 — Thomson Reuters Eikon APIs

Thomson Reuters Eikon is our flagship desktop product for financial industry professionals. As part of our efforts to establish
Eikon as a true platform that links providers and consumers of financial content, we have released a variety of Application
Programming Interfaces (APIs) for the use of our customers and our partners, as listed below.

A. SCOPE AND SCALE

The Eikon APIs are available to users with an Eikon license. Thomson Reuters Eikon is available for new and current
customers of Thomson Reuters globally.

B. TARGET AUDIENCE

e Customer IT departments needing to customize Eikon to meet their needs by building applications specific to their
workflow

e Customers who are on the more analytical and quantitative job roles who are able to write some code or scripts to
manipulate, extend, or customize some data they have within their Eikon environment. A typical description would be
expert Excel users who need to go beyond what Excel functions can do out of the box

e Partner companies who see an opportunity to build applications on our platform for distribution or co-sell side by side to
the Eikon user base. They can use our APIs to build such integrations which bring them new customer channels and
at the same time helps Eikon grow its capabilities overall

C. APP STUDIO API

Thomson Reuters Eikon’s App Studio enables developers to build financial applications integrated with and distributed through
the Thomson Reuters Eikon desktop. App Studio consists of Ul libraries, data APIs, and integration APIs to build an application.
The Web Software Development Kit (SDK) provides everything needed to build a Web application using HTML5 and Javascript
for our platform. More details can be found on the Thomson Reuters Developer Community.

D. SIDE-BY-SIDE API

The Eikon side-by-side API enables interoperability between the Eikon desktop and any other applications that are part of a
user’s workflow. The API allows for the bi-directional exchange of user context, such as the list of instruments in a watchlist or
portfolio. The APl is intended for integrations with applications that are not distributed through Eikon (see the App Studio API
above for applications distributed via Eikon). It is important to note that this API is restricted to context-passing only and cannot
be used to transmit data such as prices and values (see Eikon Data API below for access to data). More details can be found on
the Thomson Reuters Developer Community.

E. EIKON DATA API

The Eikon Data API provides our Eikon customers with programmatic access to the data they are already permissioned to
access on the desktop. It gives customers access to a reasonable amount of data to perform the type of workflow normally seen
at a desktop by a single user. This is our strategic API for Eikon data (based on REST and WebSockets technology) that
replaces the existing COM and .NET APIs (described below). There is a supported Python wrapper available for users
preferring this programming language. Other wrappers may be available from the wider developer community but they are not
supported by Thomson Reuters (e.g. community R language library in github). As a desktop offering, the user is bound by the
same Eikon single-user license which prohibits any systematic distribution or redistribution of the data and the API cannot be
used in server-based applications. More details can be found on the Thomson Reuters Developer Community.

F. COM API

The COM APIs can be used with Visual Basic for Applications (VBA), VB, C++ and various other programming languages that
can interact with COM. The APIs were specifically designed to enable the developer to build applications not possible with the
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native Microsoft Office APIs. They include the AdfinX real-time, RHistory, DEX2, RSearch, AdfinX Analytics and Eikon Excel
synchronization manager APIs. The Eikon Data APl above is our strategic APl due to its more modern Web-native and Python
technologies. More details can be found on the Thomson Reuters Developer Community.

G. .NET API

The .NET API was created for users who prefer to develop their applications using the Microsoft .NET framework. Users of the
API can access real-time streaming and snapshot data, time series data and a symbology conversion service. The Eikon Data
API above is our strategic API due to its more modern Web-native and Python technologies. More details can be found on the
Thomson Reuters Developer Community.

H. NOTE ON API USAGE

The Eikon APIs are for Eikon users running applications on their desktop machine. For server based applications, automation
and support of groups of users, Thomson Reuters provides data feed products to satisfy those API needs. By using Eikon APIs,
customers consent to Thomson Reuters retaining and processing usage data for the purposes of support, capacity planning, to
detect and prevent breaches of our network security, the law or our contract terms, and for other activities related to
administration, management and improvement of our services. Thomson Reuters may suspend or terminate access to the APIs
to protect our systems and security.

1. Discover

Thomson Reuters Eikon APIs can be discovered via search results or directly via the Thomson Reuters Developer Community
at http://developers.tr.com/eikon. The Developer Community also includes a vibrant Q&A Forum where many of the search
results may lead you to at first. Search engines may also lead you to YouTube developer-centered videos demonstrating Eikon
APIs, or github repositories where Eikon API utilities and sample code may be found - always with a link back to the Developer
Community for further discovery, documentation, and API detalils.

Partners interested in Eikon APIs to build applications targeted at Eikon users can join our Partner Marketplace at
https://financial.thomsonreuters.com/en/business-partnerships-marketplace.html.

Finally, to find out more about how Thomson Reuters Eikon and Eikon APIs can help you, please visit
http://financial.thomsonreuters.com/eikon. View capabilities by content and features or markets and industries and get in touch
directly from the website.

A. CONTACT
Developer Community: http:/developers.tr.com/eikon

Developer Q&A Forum: http://community.developers.tr.com

Eikon: http://financial.thomsonreuters.com/eikon

Eikon Partner Marketplace: https://financial.thomsonreuters.com/en/business-partnerships-marketplace.html

2. Evaluate

A. TRIAL

Most Eikon APIs can be evaluated without restrictions as long as you have access to Eikon (an Eikon login and the Eikon
software is installed on your desktop). The Eikon can be a trial Eikon. Free trials are set up via speaking with your Account
Team, and last for a period of up to 30 days. The only Eikon API that requires special permissions for evaluation is the App
Studio API. Please contact your Account Team if interested in evaluating the App Studio API.

B. SUPPORT

Thomson Reuters offers the same level of support to those on trials as it does to licensed users. More information on support
can be found later in this document.
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3. Purchase & Renew

Ordering Thomson Reuters Eikon APIs are available free of charge according to your Thomson Reuters Eikon package (Eikon
Variant). New customers who need Eikon in the first place must request an Eikon license via their Account Team. If you do not
know your Account Team you can Contact Us and we will make sure you get to the right person.

A. ENTITLEMENTS
Access to Eikon APIs, per se, does not require special entitlements. All the entitlements available to you in the Eikon product
are also applicable in the Eikon API.

For customers and partners specifically using the App Studio APIs, additional entittements will be granted to access the SDKs
(Software Development Kit) directly inside the Eikon product (under the Developer menu), as well as to access restricted pages
on the Developer Community. To become an App Studio API developer, you must follow a governance process with additional
agreements required. Please contact your Account Team if interested in using the App Studio API.

B. PACKAGING AND CONTRACT

Eikon APIs do not require any additional agreement for Eikon customers. Additional contracts will be required for partners using
Eikon APIs to build applications for Eikon users. Please contact your Partner Account Team for details if you are a partner.

Content packages available via the APIs are the same as available in your Eikon variant. If additional content is required in the
API follow the same purchase and renew process as if adding that content to the Eikon product itself. To discover the specific
content fields available in our APIs you can use Eikon discovery applications such as Content Kiosk, and the Data Item Browser
(DIB), which allow you to drill into all the available data fields for any given content package.

4. Setup

Installation Implementation and setup details for each of the Eikon APIs can be found in the Quick Start guides available for
each API as per below:

1. App Studio: https://developers.thomsonreuters.com/app-studio/app-studio-web-sdk/quick-start

2. Side by Side: https://developers.thomsonreuters.com/eikon-apis/side-side-integration-api/quick-start

3. Eikon Data API: https://developers.thomsonreuters.com/eikon-data-apis/quick-start

4. COM API: https://developers.thomsonreuters.com/eikon-com/eikon-desktop-data-api/quick-start

5. .NET API: https://developers.thomsonreuters.com/eikon-apis/net-apis-use-custom-applications

A. SOFTWARE

I.  System Requirements
All Eikon APIs require the Eikon desktop to be running on the same machine that is trying to access the API. The system
requirements are therefore the same as that of the Eikon desktop, which can be found here.

B. INSTALATION ASSISTANCE

I. Installation Instructions
Installation instructions will be delivered in English only.

Il.  Frontline Support
Frontline Support does not provide technical developer-centric API support, but can escalate to a resolver group or direct you to
the Developer Community, whichever is appropriate. The Developer Community only provides support in English.

lll. Product Functionality
Thomson Reuters Eikon APIs will be delivered in English only.
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5. Product & Usage

A. ENVISIONED USAGE
Thomson Reuters Eikon is a desktop product meant to be installed on a user’s PC for the use of the licensed user only.

B. SERVICE AVAILABILITY
Thomson Reuters Eikon (and subsequently Eikon APIs) is available 24x7 without any differentiated tiers of availability.

C. SECURITY

As the world's largest financial information source, Thomson Reuters is serious about safeguarding the security and quality of
all the proprietary and third-party information that flows through our systems. That's why we've taken steps to formalize and
embed the information security management and quality management systems into the Information Technology Infrastructure
Library, (ITIL) service management processes operated in our major data centers - including attaining certifications in two
industry-proven global standards ISO 9001 (Quality Management) and the new ISO 27001 (Information Security Management).

. Business Continuity (BC) and Disaster Recovery (DR)
Thomson Reuters Business Continuity Management Office (BCMO) maintains a business continuity policy. For further
information please contact your Account Team.

There are no options for customers to select levels of services for Thomson Reuters Eikon. By nature, any Hosted Thomson
Reuters Eikon product can be accessed via any Internet Connection. User profile, favorites, workspaces, and preferences are
all stored centrally so can be accessed anywhere. Thomson Reuters provides datacenter redundancy and failover. It is the
responsibility of the customer to obtain the correct level of service from their ISP in order to meet their own connectivity
resiliency needs.

II.  Information Security

Thomson Reuters is committed to its Information Security program and the functions’ mandate is approved by the Executive
Committee. We have a Chief Information Security Officer and an extended team of security specialists spread across the globe
dedicated to the security of Thomson Reuters Financial & Risk products and services. Our commitment to security is achieved
through the application of demonstrable security controls at an appropriate level to the service being offered. Furthermore, our
security strategy ensures that appropriate security controls exist within service design and operation. This is to counter the
threats to the confidentiality, integrity and availability of customer information which we store, process or transmit. We have staff
trained to identify issues and resolve them as quickly as possible with minimal impact on its customers. Our involvement in
industry and government security forums and groups further demonstrates our proactive approach to understanding and
countering the threats we face.

Ill. Privacy
Your privacy and trust are important to Thomson Reuters. Please consult our Thomson Reuters Privacy Statement for more
information.

IV. Legal and Regulatory

Thomson Reuters global legal department will interpret the laws and regulations that apply in the countries we operate in and
provide appropriate policies to enable us to comply with them. We operate a 24x7 Business Compliance and Ethics Hotline for
guidance or to report ethical, legal or policy issues.

V. Communications

External communications for release notes, new versions, product road map, product maintenance schedules, content change
notifications and documentation (training & user guides) updates are available through My Account and, if necessary, through
your Account Team.

VI. Security Patches

Any security issue will be assessed immediately upon being made aware of the issue. A software patch will be made available
as soon as a solution is identified and implemented. For any issue where Thomson Reuters is reliant on a third party for a
solution, communication to clients will be delivered via My Account.
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6. Support

A. TRAINING

All training and documentation is available from the Developer Community at http://developers.tr.com. This includes a quick
start guide, documentation, downloads, tutorials, a moderated community Q&A forum, and links to upcoming events such as
webinars.

B. API CONFIGURATION SUPPORT

The primary mechanism for securing API related support is via the Developer Community at http://developers.tr.com. Each API
has a dedicated site on the portal that includes quick start guides, documentation, downloads, tutorials, news and events. Each
AP site also includes a “Q&A” section that allows users to browse previously asked questions as well as to pose their own
“how-to” questions to the broader community. These Q&A pages are actively monitored by the Developer Community team who
will aid the customer in the best way possible.

The Q&A forum at http://community.developers.tr.com is open for all developers to ask and answer questions, monitored by a
global Thomson Reuters team. This team is a rotating group: one person in Asia, one in EMEA, one in America. They try to
answer questions as soon as possible aiming to have all questions answered within a week, so long as they are answerable.
Questions are often answered much faster than that, even within an hour. The team may answer the questions themselves or
refer the question to the appropriate subject matter expert.

C. EIKON CONTENT AND TECHNICAL SUPPORT

All inquiries relating to Thomson Reuters Content and Technical Delivery will be directed to our Customer Support Desk. These
inquiry types include Content Search, Content Integrity, Content Definition, Connectivity, Application Malfunction and User
Entitlement.The following sections describe in more detail the service level provided by our Customer Support Desk.

D. SUPPORT CHANNELS, SUPPORT LANGUAGES AND AVAILABILITY

I.  Live Chat
Live Chat support follows the general Eikon Live Chat model.

Live Chat does not provide technical developer-centric API support, but can escalate to a resolver group or direct you to the
Developer Community, whichever is appropriate.

Il.  Customer Support
Customer support is delivered in the same way as the general Eikon Customer Support.

Frontline Support does not provide technical developer-centric API support, but can escalate to a resolver group or direct you to
the Developer Community, whichever is appropriate.

Ill. Resolver Groups
Resolver groups follow the general Eikon Resolver Groups model.

E. SUPPORT MODEL
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7. Evolution

A. UPDATES

Regular updates to Eikon APIs will be made available as the company sees fit. Most of these updates are included as part of
the regular Eikon release process and will require you to upgrade your version of Eikon to take advantage of the latest
functionality. Some API updates which involve standalone installable components will be made available from the Developer
Community or via common package distribution systems such as PIP for Python and NuGet for .NET.

You can see your current Eikon version in Help > About Thomson Reuters Eikon. Client administrators can see which version
of Eikon their users are on via My Account.

We will support versions in the same manner as the general Eikon versions are supported.

B. MIGRATIONS

Thomson Reuters offers migration assistance to existing customers of Thomson Reuters’ products (including Eikon APIs), as
well as to new customers migrating from other financial market data products and APIs. Please contact your Account Team in
order to discuss migration needs.

C. STRATEGIC MIGRATION

Strategic Migrations are the transition from a legacy Thomson Reuters product to a new proposition. Any Eikon API strategic
migration will follow the general Eikon'’s strategic migration plans. If there are Eikon API-specific strategic migrations, they will
follow the process below.

e Your Account Team will contact you in case we embark on a strategic migration. Notices of strategic API migrations
will also be posted on the Thomson Reuters Developer Community.

e  Core API functionality will be provided in the form of new API versions and new API documentation and SDKs.
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Eikon APIs are not provided as add-on elements but in the case of add-on content sets purchased for Eikon proper,
any Eikon API strategic migration will honor any content add-on entitlements previously purchased.
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